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Chapter 1

Description

HI-TIDETM 3 (HI-TECH Software’s Integrated Development Environment v3.xx), based
on the Eclipse Platform and CDT, provides an easy-to-use interface to HI-TECH C
compilers and enhances code development.

The Eclipse Platform is an open-source IDE that provides an open platform for the
integration of tools. CDT is an extension of the platform that provides generic support

for C language development. Basing HI—TIDETM on this platform allows HI-TECH
Software to focus on developing unique embedded development tools, such as hard-
ware debuggers, simulators, and code-generation tools for microcontroller peripherals.
The Eclipse platform brings with it well-tested and widely used tools such as CVS
integration, editor code completion, source outlines, etc.
This release includes: fixes for bugs found in previous versions of HI-TIDE, MPLAB

ICD 2 support extended to cover most PIC and PIC18 MCUs, new peripherals sup-
ported by C-Wiz, and PICC PRO Beta compiler support.
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New Features

2.1 MPLAB ICD 2 Debugger

PIC18 Support (3.13) New to HI-TIDE is MPLAB ICD 2 hardware debugger support
for PIC18 devices. One hundred devices are supported. For a list of supported
devices see section 7.3.2.

PIC Support (3.13) An additional 42 devices are supported, including the 16F88x,
and 16F91x families. For a full list of supported devices see section 7.3.2.

2.2 HI-TIDE UI

Sample Project Import Wizard (3.13) HI-TIDE now has a new sample project im-
port wizard. The import wizard has simplified the process of importing sample
projects from HI-TECH Software’s compilers. To access the import wizard se-
lect File->Import.. from the menu bar, then select Import HI-TECH Sample
Project.

The Import Sample Project cheat sheet provides a tutorial.

2.3 Compiler Support

PICC PRO v9.60 Beta (3.12) PICC PRO v9.60 Beta is now supported.'

24 C-Wiz

PIC18 Peripheral Support USART(3.12) The USART peripheral is now supported
in C-Wiz for all PIC18 microprocessors.

1C/C++ Build Tool Settings and HI-TECH Debug Variables view support are not complete. Some tool
settings are missing and some unnecessary settings are displayed. The value for pointer variables in the
Variables view may be incorrect.
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Bug Fixes

The following are descriptions of bugs that were present in the previous version(s) of
HI-TIDE and have been fixed in this release. The version in brackets indicates the
version that the bug was fixed.

3.1 Compiler UI

3.2 Compiler Core

Error Opening Project (3.13) - Opening some projects in HI-TIDE caused a Man-
aged Make Project File Error. The error occurred when several conditions
were met. The first condition is that the project was created by a previous ver-
sion of HI-TIDE. The second condition is that the PICC-18 STD compiler was
selected for the project. The final condition is that the compiler version was be-
tween 9.50 and 9.50PL2 inclusive.
The error was indicated by the Managed Make Project File Error dialog which
contains the text:
The Managed Make project file could not be read because of the following
error:

[Ljava.lang.Object

Managed Make functionality will not be available for the
this project.
The release fixes the bug above.

Incorrect CDT Indexer Warning (3.13) The indexer incorrectly issued a warning if
source code included a header file from the include path. The incorrect warning
is:

C/C++ Indexer Problem: Preprocessor Inclusion not found:....



Bug Fixes Distribution

The warning occurs because the indexer is not extracting the paths from the
Include Paths option. This option is found in the project properties dialog in the
common options section of Tool Settings tab of the C/C++ Build page.

The fix adds an extra Include Paths option. The option has been added to the
Compiler or Pre-Processor/Parser tool on the Tool Settings tab for STD and
PRO compilers respectively. The fix applies to the dsPICC, PICC, and PICC-18
compiler, both PRO and STD. The index will extract paths from the new Include
Paths option.

Incorrect Error on Project Import (3.13) When importing a project HI-TIDE some-
times incorrectly detected that the compiler was missing from the project. When
this happened the Compiler Selection dialog was shown. Further, if you se-
lected a new compiler and pressed OK, the C/C++ Indexer dialog was shown.
This dialog did not contain any text. Finally, when the C/C++ Indexer is closed
HI-TIDE would not be able to build the project.

This bug is fixed in this release.

Build Hang (3.13) On some Windows platforms the workspace build process would
hang. When hung you would see on the right hand side of the status bar Building
Workspace: (0%) until you terminated HI-TIDE. Also, even though user inter-
face is still responsive, the build process blocked other actions such as saving
source file.

HI-TIDE uses a third party program, make, to build projects and it is this pro-
gram that caused the hang. With a version update to the make program the build
process no longer hangs. This updated version is now distributed with HI-TIDE.

3.3 Distribution

Online Update Restart Failed (3.13) After updating HI-TIDE via an online update
HI-TIDE sometimes would fail to restart issuing and internal error on startup.
HI-TIDE was only able to start again after running it with the -clean command
line option.

With this fix you will be able to update to this release from older releases without
the internal error occurring.

Online Update Error (3.13) In some circumstances when HI-TIDE is at the end of
installing an online update it will display an error dialog. The error will only
appear if HI-TIDE hasn’t installed an online update before. The contents of the
error dialog are:
Unable to complete action for feature "HI-TECH Software Development
Tools" due to errors.
InstallHandler.deactivated
Custom install handler required by feature "HI-TECH Software Development
Tools" was not found. [com.htsoft.hitide.install.InstallHandler]
InstallHandler.deactivated
Custom install handler required by feature "HI-TECH Software Development
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Tools" was not found. [com.htsoft.hitide.install.InstallHandler]
The updated HI-TIDE functions normally after restart.
With this release this error no longer occurs.

34 C-Wiz

34.1 PIC18

PortB Interrupt-On-Change (3.13) The Port B Interrupt-On-Change configuration
was missing from C-Wiz for PIC18 chips.
The fix now allows the Interrupt-On-Change feature to be configured.

MSSPx Interrupt Creation (3.13) C-Wiz wasn’t creating code for some Serial Port
settings in MSSPx peripherals. Specifically C-Wiz wasn’t creating interrupt han-
dling code for these peripherals when requested.

Now C-Wiz creates interrupt handling code for the MSSPx Serial Port peripher-
als.

3.5 Debugger Ul

Debugger Internal Error (3.13) In some instances, when debugging, an internal er-
ror occurs. The full content of the error dialog is: An internal error occurred
during: "Debug async queue.” For the error to occur the Variables view
must be showing at least one variable.

This bug has been fixed in this release.

Missing Memory View Content (3.13) The Memory View didn’t display configura-
tion register values when using the PICC and PICC18 debuggers. This problem
effected the simulators and hardware debugger.

The memory now correctly displays configuration register values.

Incorrect Disassembly (3.13) The Disassembly view displays mixed C and assem-
bly incorrectly on some occasions. It shows several assembler instructions and
below it will show those same instructions again unnecessarily. It displays the
unnecessary instructions most commonly when disassembling while and for
loops.

The Disassembly view now does not display the unnecessarily instructions.
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Limitations

4.1 Debugger Ul

Variable View The address contained in function pointers is displayed correctly, but
the symbolic function name associated with this address is not displayed.

4.2 MPLAB ICD 2 Debugger

Chip Support The PIC baseline and PIC18FxxJxx parts are not supported by the
MPLAB ICD 2 Debugger at this time.

Programming Support Programming support is not currently available.

Communication HI-TIDE is currently not able to communicate via USB.

43 C-Wiz

EUSART Support At this time the EUSART peripheral is not supported.
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Online Updates

Updates to the IDE can now be downloaded from within HI-TIDE. To update select
Help->Software Updates->Find and Install... from the menu bar. Then when the
Install wizard appears, select HI-TECH Software Updates and select Finish to com-
plete the wizard.

Once the Install wizard is complete the Update wizard is shown. Select HI-TIDE
update site, and complete the pages in the wizard as required.

Once the wizard is finished the Verification dialog will appear. This dialog displays
the certificate details used to sign the files that are being downloaded. A certificate
provides a digital signature that allows verification that the downloaded files originated
from the expected party, here HI-TECH Software.

There are three key items in the dialog that should be verified before proceeding
with the install. First, the text The provider of this feature has been validated by
a trusted third party should appear towards the top of the dialog. Second the File
signed by text box should contain, among other things, the URL to the HI-TECH
Software update site, updates.htsoft.com, and a valid date range. Third the According
to text box should contain, among other things, the URL to the Go Daddy Secure
Certification Authority Repository, http://certificates.godaddy.com/repository and a
valid date range.
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Compiler Support

For a list of compilers and associated features pleader refer to the table 6.1.

Table 6.1: Supported Compilers and Associated Features

Compiler Project Management | C-Wiz | Simulator Hardware Debugger
PICC STD v9.50+ Yes Yes Midrange only. | MPLAB ICD 2
PICC-18 PRO v9.60+ | Yes Yes Yes MPLAB ICD 2
PICC-18 STD v9.50+ | Yes Yes Yes No

dsPICC STD v9.60+ | Yes No No No
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Debugger Notes

7.1 PIC18 Simulator

Core simulator support is implemented for all PIC18 microcontrollers known at the
time of release.
The below is a list of simulated peripherals:

e Reset

Reading/writing to Flash (includes J parts)

Reading/writing to EEPROM

Reading/writing to External memory (timing not simulated)

Timers 0-4

Interrupts for the above triggers

7.2 PIC Simulator

Core simulator support is implemented for all PIC midrange microcontrollers known
at the time of release. Baseline and high-end devices are not supported.
The below is a list of simulated peripherals:

e Reset

Reading/writing to Flash
e Reading/writing to EEPROM
Timers 0-2

Interrupts for the above triggers

10
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7.3 MPLAB ICD2 Debugger

7.3.1 Operating System (Firmware) Files

PIC12F/16F v2.07.02  (ICD01020702.hex)
PIC10F2XX, PIC16F54/57 v1.04.03 (ICD07010403.hex)
PIC16F68X v1.05.00 (ICD08010500.hex)
PIC12F629/675, PIC16F630/676  v1.00.00 (ICD09010000.hex)
PICI8F v2.07.05 (ICD04020705.hex)
PIC18F Extended v1.04.01 (ICD05010401.hex)

7.3.2 Debugger Device Support List

12F629! 12F635! 12F675! 12F683!
16F627A!  16F628A!  16F630! 16F631!
16F636! 16F639! 16F648A!  16F676!
16F677! 16F684! 16F685! 16F687!
16F688! 16F689! 16F690! 16F716!
16F737 16F747 16F767 16F777
16F785! 16F818 16F819 16F87
16F870 16F871 16F872 16F873
16F873A  16F874 16F874A  16F876
16F876A  16F877 16F877A  16F88
16F883 16F884 16F886 16F887
16F913 16F914 16F916 16F917
16F946 16HV785

18F1220 18F1230 18F1320 18F1330
18F2220 18F2221 18F2320 18F2321
18F2331 18F2410 18F242 18F2420
18F2423 18F2431 18F2439 18F2450
18F2455 18F2458 18F248 18F2480
18F2510 18F2515 18F252 18F2520
18F2523 18F2525 18F2539 18F2550
18F2553 18F258 18F2580 18F2585
18F2610 18F2620 18F2680 18F2682
18F2685 18F4220 18F4221 18F4320
18F4321 18F4331 18F4410 18F442

18F4420 18F4423 18F4431 18F4439
18F4450 18F4455 18F4458 18F448

18F4480 18F4510 18F4515 18F452

18F4520 18F4523 18F4525 18F4539

11
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18F4550 18F4553 18F458 18F4580
18F4585 18F4610 18F4620 18F4680
18F4682 18F4685 18F6310 18F6390
18F6410 18F6490 18F6520 18F6525
18F6527 18F6585 18F6620 18F6621
18F6622 18F6627 18F6680 18F6720
18F6722 18F8310 18F8390 18F8410
18F8490 18F8520 18F8525 18F8527
18F8585 18F8620 18F8621 18F8622
18F8627 18F8680 18F8720 18F8722

7.3.3 Operating System Support List
Windows XP SP2, Windows Vista 32-bit, GNU/Linux 64bit, and Mac OS X

e Only initial testing has been performed on 32-bit Vista for this release. 64-bit
Vista is not supported at this time.

NOTE: Windows NT and Windows 98/ME OSes are not supported.

7.3.4 Communication

HI-TIDE is able to communicate to the MPLAB ICD 2 via the a (RS-232) connection.
USB connections are not supported at this time.

NOTE: For platforms (PC, Mac, etc) that do not have a RS-232 port a USB-to-
serial adapter can be used.”

7.3.5 Reference Documents
The following documents may be found on the Microchip website:
e MPLAB ICD 2 Design Advisory (DS51566)
e Using MPLAB ICD 2 Poster (DS51265)
e MPLAB ICD 2 User’s Guide (DS51331)
e Header Specification (DS51292)

e Universal Programming Module Instruction Sheet (DS51280)

'Header interface board required. See MPLAB ICD 2 Header Specification (DS51292), for a list of
available headers by device number.
2The Keyspan® USA-19HS adapter has been tested on the operating systems above.
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7.3.6 Powering the MPLAB ICD 2 and Target Board
NOTE: MPLAB ICD 2 must be powered BEFORE power is applied to the target ap-
plication.
7.3.6.1 MPLAB ICD 2 Power
Serial (RS—232) connection to the PC:
Power supply required.
7.3.6.2 Target Board Power

The MPLAB ICD 2 can provide 5 V and up to 200 mA to a target if the ICD itself is
powered by a power supply.

7.3.7 Setting Up the MPLAB ICD 2 and Target Board

Following the instructions in the Debugging with the MPLAB ICD 2 cheat sheet.
The cheat sheet can be accessed by selecting Help->Cheat sheets... from the menu
bar. Once the Cheat Sheet Selection dialog is open expand the HI-TIDE Cheatsheets
folder and select Debugging with the MPLAB ICD 2.

7.3.8 Known Problems

The following is a list of known problems.

7.3.8.1 General Issues
e For baseline devices, TRISIO and OPTION_REG cannot be read.

e For PIC18F8720, MEMCON cannot be read if in a microcontroller mode. This
is a silicon issue.

e You may not be able to enter debug mode if power-up timer is enabled for the
following devices:

PIC18F4620/4610/2620/2610
PIC18F4680/2680/4681/2681
PIC18F4520/4420/2520/2420
PIC18F4550/2550/4455/2455
PIC18F8490/8410/6490/6410/8390/8310/6390/6310
— PIC18F8722/8627/8622/8527/6722/6627/6622/6527

e MPLAB ICD 2 may not operate on a dual processor platform in dual processor
mode. It is recommend that you change the application properties for MPLAB
ICD 2 to single processor mode.

13
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e On PIC16F88X devices it is necessary to pull the RB3/PGM pin low for ICSP
programming. This is due to a silicon issue.

e When connecting the PIC16F818/819 to the latest MPLAB ICD 2’s (r3), the
device may latch resulting in the error Error creating debugger: Chip ID is 0.
Check that the target board is powered and connected to the MPLAB ICD
2. A work around is to use a .1 uF capacitor on VPP to GND.

7.3.8.2 System Service Requests (SSRs)

SSR 20230: Programming or reading a code-protected EEPROM memory generates
no messages by MPLAB IDE for MPLAB ICD 2 for a PIC12F675 device.

SSR 24354: Some peripherals do not freeze. This is a silicon issue.

SSR 26344: Below 4.5 V, MPLAB ICD 2 will not over-program User IDs on these
devices:

PIC12F635 PIC16F684 PICI16F689 PIC16F914
PIC12F683 PICI16F685 PICI6F690 PIC16F916
PIC16F636 PIC16F687 PIC16F785 PIC16F917
PIC16F639 PIC16F688 PIC16F913 PIC16F946

SSRs ICD2-37, ICD2-72, ICD2-81, ICD2-82: As a general comment on these
issues, some devices may not be able to enter debug mode at 32 kHz speed.

SSR ICD2-109: When connecting the PIC16F818/819 to the latest MPLAB ICD
2s (1r3), the device may latch resulting in the error Error creating debugger: Chip ID
is 0. Check that the target board is powered and connected to the MPLAB ICD
2. To work around the issue, reduce the cable length to less than 6 inches. Also, if
AC162049 is being used, remove the R1 pull-up resistor. Some devices require that
a .1uF bypass capacitor be placed from the Vdd pin to the Vss pin of the device to
successfully program the device. If programming failures still arise, try increasing this
value incrementally to a maximum of 10uF.

SSR ICD2-140:When the command to erase EEPROM in the device at 3.1V, the
EEPROM in the device gets reprogrammed in the same voltage. Please note that below
3.0V, EEPROM will not be erased.

7.3.9 Important Notes
o The following applies to all devices except for Extended PIC18F Devices V2:
e While single stepping, the MPLAB ICD 2 will not respond to interrupts.
e The SLEEP instruction cannot be used when debugging.

e The WDT cannot be used when debugging.

— An exception to the single step SLEEP and WDT in the above notes:

— Extended PIC18F Devices V2 will allow the user to interrupt while single
stepping, use SLEEP, use WDT.

14



Debugger Notes MPLAB ICD2 Debugger

For PIC18Fxx20 devices, you must connect the AVDD and AVSS pins for
the devices to program.

Make sure that table reads/writes are not code protected.

In low voltage mode, bulk erase will not erase code protect bits.

When using a 32 kHz crystal, you may receive the error Unable to en-
ter into debug mode. Check that the oscillator is configured correctly.
Relaunch the debugger to enter debug mode.

7.3.9.1 Firmware

e MPLAB ICD 2 has different OS’s for different part families. HI-TIDE will au-
tomatically download the correct OS as necessary.

7.3.10 Reserved Resources

The MPLAB ICD 2 uses on-chip resources when debugging, i.e., some device re-
sources are reserved for use by MPLAB ICD 2. The resources required by the MPLAB
ICD 2 will be reserved by the compiler if the Microchip ICD 2 option is set to ICD2.
You can find this option by right clicking on a project in the C/C++ Project view, then
selecting Properties. Once the properties dialog has opened select C/C++ Build from
the list on the left of the dialog. The make sure the Tool Settings tab is selected. From
the Tool Settings tab select the Debugging options category. In this category you will
find the Microchip ICD 2 option.
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Licensing

e Visit http://www.eclipse.org for licensing information for the Eclipse Pub-
lic License.

™
e The Sun Java Runtime Environment - License can be found in the file sun-jre-license.txt

™
in the HI-TIDE 3 distribution’s docs directory.

™ ™
e DOM4J  -License can be found in the file dom4 j-1icense.txt inthe HI-TIDE 3
distribution’s docs directory.

o This product also uses source code provided by Sun. This source code is covered
under the license found in the file sun-samples-license.txt.
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